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The pendent drop method for surface tension measurement consists in
analysing the shape of an axisymmetric drop hanging from a capillary tube
(Fig. 1). This article describes the principle and some practical considerations
in implementing this method, both experimentally and numerically. Our
numerical tool to match a theoretical profile to the contour of a pendent
drop, either interactively or automatically, is available as an open-source
Pendent_Drop Plugin for ImageJ [1]. This Plugin provides an estimate of
the surface tension and other drop characteristics such as volume and surface
area from the best matching parameters. We also present static and dynamic
surface tension measurements on various liquids and a biosurfactant solution
showing that this Plugin calculates values in accordance with known surface
tensions and with those obtained via a commercial apparatus.

1. Introduction
The pendent drop method is commonly used to measure surface tensions of liquids. It
consists in analysing the shape of a drop hanging typically from a capillary tube and
about to detach. The method can also be applied to drops resting on a flat surface.
For transparent liquids and in order to minimise interface contamination by adsorption
from the gas phase, one can also work with bubbles, again either sessile or detaching
from a tube. The shape of large drops or bubbles results from a competition between
gravity, which tends to lengthen hanging drops or flatten sessile drops, and cohesive
forces among liquid molecules which tend to produce compact, spherical drops. As
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Figure 1: (a) Experimental set-up for pendent drop surface tension measurement: a
drop is hanging from a capillary tube (diameter here: 1.68mm). A light source far
behind the drop provides a bright background against which the drop is photographed.
(b,c) Drops of water and perfluorated oil close to the maximum volume before drop
detachment. It is easy to see that the difference in surface tension has a tremendous
effect on the drop shape. The pendent drop method consists in exploiting this strong
dependency in order to determine an unknown surface tension. (d,e) After improving
experimental conditions to get rid of spurious reflections and to enhance contrast.

shown in section 4, the resulting drop profile is described by only one non-dimensional
parameter (tip radius over capillary length), although in practice five parameters have
to be adjusted on a given image of a drop to account for unkown translation, rotation,
scale and drop volume. In the Plugin presented here for example, the five parameters
are the tip position and curvature, the tilt of symmetry axis and the capillary length.
The profile determined this way gives access, besides to the surface tension, to other
drop properties such as volume or surface area.
While both the theory and the set-up are rather simple and straightforward, to get

precise, reliable and trustworthy results requires some care in experimental details. Note
for example that surface tension depends quadratically on the capillary length, so that
any error in the length measurements will result in twice that relative error on the surface
tension:

γ = ρg`2 ⇒ ∆γ
γ

= 2∆`
`

The pendent drop technique is well established and there are numerous high quality
commercial devices to measure not only static, but also dynamic properties of interfaces.
These are however often available only in laboratories specialised in interface physics and
chemistry. Here we show that within a few hours and with readily available and cheap
material, high quality measurements can be achieved. This is not only useful to the
biologist, geologist or environmental scientist who stumbles onto a case where surface
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Figure 2: Schematics of a simple surface tension measurement set-up. The horizontal
distances are much larger than depicted, both the light source and the camera being
at about 30 cm from the drop, while the condenser lens has a diameter of 25 mm. We
use a commercial DSLR camera with a Zeiss 50 mm Macroplanar objective, and a
light emitting diode as a light source.

tension is a crucial parameter, but also enables college or high school teachers to explore
the fascinating physico-chemistry of interfaces and surfactants (an example of surfactant
adsorption dynamics is presented below).
As a rough rule, if a 2 %–5 % uncertainty on the surface tension is acceptable, a very

simple set-up using a web-cam and a light source a metre away should be sufficient.
This article describes a slightly more involved optical set-up using parallel light and a
macro objective, and underlines the pitfalls that must be avoided in order to get a result
that should be well within about 1 % of the true value. As always in metrology the
experimental difficulty increases very quickly with the desired precision, as more and
more small physical phenomena start having a noticeable effect on the measurement.
Relative uncertainties of and below 10−3 are beyond the scope of this article, requiring an
improved set-up with a telecentric objective and much better control of the atmosphere,
temperature, vapour pressure, vibrations et cætera than was attempted by the authors.
The structure of this article is as follows: the two following sections 2 and 3 describe

the measurement bench and present data measured with the Plugin in comparison to
reference data. Sections 4 and 5 describe the underlying theoretical framework and the
plugin’s inner architecture, respectively. Appendix A summarises the properties that the
input image must have for the Plugin to give meaningful results, and the appendices B
and C contain usage and installation instructions for the Pendent_Drop surface tension
measurement Plugin for ImageJ.

2. Measurement bench
Our measurement set-up is depicted in fig. 2. The condenser is at its focal length from
the light source diaphragm, so that light rays are parallel to the optical axis in the limit
of a closed diaphragm. The camera is focalised on the drop. The drop is extruded either
from a Pasteur pipette, or from a micropipette plastic tip. The pipette is connected to
a syringe that is driven either by hand or by a syringe pump.
This basic measurement bench is quite easy to set up. It can even be simplified further

by replacing the light source and condenser by a bright screen at a large distance from
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Figure 3: Light reaching the drop from direction A will be partially reflected towards
the camera, whose focal plane cuts through the drop at F . The light will appear as
coming from point A′, and be almost as bright as direct light from e.g. B, because the
reflection coefficient tends to unity for near grazing incidence. As a result, the drop
may appear slimmer than it is.

the drop. In any case the drop appears dark against a light background, because even
for transparent liquids light rays traversing the drop will be refracted at the interface
and miss the camera entrance pupil (except at the very center of the drop, where a small
image of the light source can be seen because the interfaces are perpendicular to the
optical axis).
Despite the simplicity of the set-up is important however to be aware of a few effects

that can affect the measurement quality. The drop can indeed appear smaller than its
real size for several reasons. One consists in grazing reflections at the border of the drop
(fig. 3). For incident angles above about 82◦ on water for example, the reflected intensity
lies above 50 % of the incident intensity, so that the corresponding points on the drop
will be classified as outside. This corresponds to an error on the drop radius of about
1 %, and therefore an error on the surface tension of 2 %. Note that the error on the
surface tension is most likely even larger, because eroding the drop image by a few pixels
does not amount to a mere change in scale: the drop’s vertical extent is usually larger
than its horizontal diameter, so that eroding sides and bottom by the same amount of
pixels will change its aspect ratio and lead to an unphysical profile that cannot even be
accurately adjusted by the Young-Laplace equation any more.
The condenser set-up prevents this source of errors by providing only near-parallel

light rays. Alternatively this selection of light parallel to the optical axis can also be
achieved by a telecentric lens on the camera side, as this type of lens is precisely built to
have its aperture stop virtually infinitely far from the imaged object. Using a telecentric
lens comes with the added benefit of having a magnification which is independent of
the drop’s distance to the camera, thereby reducing potential errors when calibrating
the image scale. The commercial apparatus against which we validate our measurement
bench and numerical analysis (see next section) uses such a telecentric lens, and a simple
back-lit ground glass as an extended omnidirectional light source.
Errors also arise from oversaturating the image sensor, for two reasons. One is that

common CCD and CMOS sensors present some degree of blooming, meaning that elec-
trons from oversaturated pixel wells overflow into adjacent pixels and/or fail to com-
pletely transfer (mainly in the case of CCDs) during pixel read-out, causing neighbouring
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water hexadecane mercury
Temperature 303 K 303 K 295 K

Density 995.7 kg/m3[7] 767.7 kg/m3[8] 13 541 kg/m3[7]
capillary length . . .

from literature 2.70 mm[7] 1.885 mm[9] 1.89 mm (293 K)[7]

imaging and analysis: 2.703 mm 1.863 mm 1.70 mm
our set-up and sofware ±0.015 mm ±0.018 mm ±0.015 mm

imaging and analysis: 2.697 mm 1.882 mm —
commercial apparatus ±0.01 mm ±0.02 mm

imaging: com. apparatus 2.750 mm 1.890 mm —
analysis: our software ±0.01 mm ±0.03 mm

Table 1: Comparison of capillary lengths of three liquids from different sources.

pixels (viz pixels in the same column) to appear much brighter than they should. The
second reason is that our Plugin puts the drop interface at half the intensity contrast
between drop and background. If the background intensity is oversaturated and the cap-
tured picture therefore presents intensities clipped to values below a maximum, the 50 %
threshold on the (clipped) pixel values amounts to a lower threshold on the real intensity
interval, again effectively shifting the drop contour inwards. To prevent these effects the
background illumination must be as uniform as possible, and the camera aperture and
exposure time chosen so as not to saturate the sensor.

3. Validation measurements
The following table compares capillary length measurements for three liquids (water,
hexadecane and mercury) using our set-up and sofware with values from the litera-
ture and values measured using a commercial apparatus (Teclis Instruments: Tracker,
software version 9.7.0). Additionally, we report the capillary length that our software
determines from images taken on the commercial apparatus. In all cases the indicated
uncertainty is the standard deviation of three to twelve drops, each measured two to
four times (varying lighthing, exposure settings and the part of the drop to which the
theoretical contour was adjusted). Mercury vapour represents a health hazard, and its
vapour pressure depends strongly on the temperature[6]. Considering the high summer
temperatures of around 30 ◦C, we refrained from performing measurement of mercury
drops using the commercial apparatus which could not easily be relocated. We could
however transfer our bench to an air-conditioned room to perform the measurement on
mercury at about half the vapour pressure.
Our measurements for water and hexadecane agree with literature values as well with
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Figure 4: Surface tension of a drop of surfactine solution over time.

the values obtained through the commercial apparatus. The measurements for mercury
yield a capillary length about 10 % lower than expected. We suspect that oxidation of
its surface in air may have been responsible for lowering the surface tension. Analysing
the images from the commercial apparatus with our software slightly overestimates the
capillary length of water, possibly to a small error on the independently performed image
scale calibration. In any case, all measurements for water and hexadecane differ by less
than 1 %, giving a conservative estimate of the precision of our set-up and analysis.

3.1. Example of slow surfactant dynamics
If the surface tension varies over time, the measurement of the surface tension on suc-
cessive images can be performed efficiently by taking each result of a fit as a starting
guess for the adjustment of the following image, which is what the Pendent_Drop Plu-
gin will do automatically if run on a stack. Fig. 4 shows the time evolution of the
capillary length and surface tension of an acqueous solution of surfactine, a lipopeptidic
bio-surfactant (molecular weight 103 Da) produced by the bacteria B. subtilis. When the
drop is initially extruded from the capillary, fresh interface is created that is only weakly
populated with surfactant molecules, so that the surface tension is close to that of pure
water. Over time surfactant molecules diffusing in the liquid reach the free surface and
adsorb to the interface. It takes several minutes for the molecule concentration at the
interface to reach an equilibrium.
The irregular decrease of the surface tension, especially the sudden drops around

t = 70 s and t = 130 s are not due to measurement errors, but to variations of the drop
volume by the human operator. Recall that for a reliable surface tension measurement
the curvature must vary significantly from top to bottom, therefore the drop size needs
to be of the order of the capillary length. However the drop is then also close to pinch-
off because the maximum drop size before pinch-off is of the order of (d`2c)1/3 where d
is the tube diameter. As the surface tension, and thus `c, decreases over time in the
case of the surfactine drop, the drop volume has to be diminished to prevent pinch-off,
by pulling liquid back into the capillary tube before the drop becomes unstable. This
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reduces the free surface and increases the surface density of surfactant molecules, which
in turn results in a further decrease of the surface tension. On the other hand, if the
drop volume is increased as around t = 180 s, the drop surface also increases and the
surfactant is diluted at the interface, increasing the surface tension. In order to measure
the change in surface tension excusively due to adsorption of new surfactant molecules,
a feedback loop is needed that maintains a constant drop surface.

4. Physics of the pendent drop
Cohesive forces between the molecules of the liquid prevent the pendent drop from de-
taching under its weight, up to a critical size. The effect of these cohesive forces is
thermodynamically described by a contribution γ dS to the free energy that is propor-
tional to the surface variation dS, where γ is the surface free energy or surface tension.
In other words, cohesion is accounted for by considering that the free surface of a liquid
is under tension, and the equilibrium shape is one minimising this surface together with
the potential energy.
To establish an equation describing the shape of an axisymmetric pendent drop (fig. 5),

it is easier to consider the local pressure balance. Just like the pressure inside of a rubber
balloon is higher than outside, surface tension is responsible for a pressure jump across
a curved interface, that is related to its mean curvature κ̄ by Young-Laplace’s formula
∆p(z) = γκ̄(z).
Now in a pendent drop the pressure jump across the interface varies with height,

because of the density difference between the inner liquid and outer gas phase, implying
that the surface curvature must vary as well. Indeed, the drop has an equilibrium shape if
and only if the hydrostatic pressure difference is everywhere equal to the Young-Laplace
pressure jump across the interface.
Take the lowest point of the drop as origin for the height coordinate z. Then the

pressure inside the drop is pin(z = 0) − ρingz at a distance z above it, while it is
pout(z = 0) − ρoutgz outside at the same height. g denotes gravitational acceleration
and ρin/out the densities of the respective phases. Noting ∆p0 = pin(z = 0)− pout(z = 0)
the pressure drop at the drop tip, and ∆ρ = ρin − ρout the density contrast, we have a
pressure jump across the interface ∆p(z) = ∆p0 −∆ρgz at height z. Note that the value
of ∆p0 is unkown beforehand. It depends on the geometry of our set-up and the drop
volume, and constitutes an integration constant.
At equilibrium, this hydrostatic pressure jump is equal to the Laplace pressure given

above: ∆p0−∆ρgz = γκ̄(z). We parametrise the drop surface in cylindrical coordinates as
(R(s), Z(s)), where s is the curvilinear distance to the tip along the interface. Expressing
the mean curvature as a function of R, Z and the angle ψ between the tangent plane
to the interface and the horizontal: dR/ds = cosψ, one obtains the following expression
for the pressure equilibrium:

− 1
`2c

sinψ = d
ds

(dψ
ds + sinψ

R

)
.
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Figure 5: Notations. The drop profile is assumed to be
axisymmetric, and is described by the two cylindrical
coordinates R(s) and Z(s) as a function of the curvilin-
ear parameter s. The local tilt ψ with respect to the
axis normal enters the expression for the interface cur-
vature, and is related to R through R′ = cosψ. We have
spherical symmetry at the very tip, with radius r0.

The boundary conditions at the drop tip are ψ(0) = 0 and dψ/ds = p(0)/2γ = 1/r0 =
const., where r0 is the radius of curvature of the drop tip which has locally spherical
symmetry. Scaling all lengths by the characteristic length `c =

√
γ/∆ρg (called capillary

length) yields one universal drop shape equation

− sinψ = d
ds

(dψ
ds + sinψ

R

)
with ψ(0) = 0 and ψ′(0) = `c/r0, (1)

Note that the solutions (i.e. all possible axisymmetric drop shapes) are fully deter-
mined by the choice of the initial condition for ψ′(0), which is just the ratio of the
capillary length and the radius of curvature of the drop tip.

5. What the Plugin does internally

numérical integration
The equation (1) is integrated for a given parameter `c/r0 = 1/r∗ using a fourth order
Runge-Kutta scheme. Near the drop tip the integral equation becomes singular asR→ 0,
but the solution itself is perfectly regular: it is simply a nearly perfectly spherical profile
(at least at distances small with respect to capillary length and tip radius). We can thus
use an analytical solution to get away from the singularity at R = 0. The leading order
terms of that solution are

R = r∗ sin s
r∗

+ s5

40r2
∗

+O(s6)
Z = 1

2r∗
s2(1 + ( 1

16 −
1

12r2
∗
)s2) +O(s6)

ψ = s/r∗(1− s2/8) +O(s5)

 for s� 1 ∧ s� r∗

We use this solution to calculate the first piece of drop contour where s � 1 and
s� r∗. Then we continue through numerical integration.

matching the theoretical solution to the image of the drop
The drop contour from the previous integration is then rescaled, translated and rotated
according to the given parameters (tip position, curvature, and gravity angle) to be
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compared to the experimental drop image. A distance between this theoretical contour
C and the observed drop border B, is then calculated as the sum, over all pixel rows and
both sides of the drop, of the difference of horizontal positions:

χ2 =
∑

z

|xC,left(z)− xB,left(z)|2 + |xC,right(z)− xB,right(z)|2

The drop border B is detected beforehand by matching a step-function to the image
intensity profile in a neighbourhood of the interface.

optimize by varying parameters and iterating
In case automated fitting of some parameters is requested (by pressing the “fit” or the
“OK” button), the Plugin tries to minimise the distance function χ2 using an algorithm
by Powell [4, 5]. This algorithm consists in successively varying each parameter, search-
ing for each the value that will yield the best-fitting integrated drop contour. The user
can choose which parameters are adjusted in this prodecure, and which ones are kept
fixed. After all free parameters have been varied, the algorithm checks whether it is
not more efficient to minimise along another direction in parameter space, i.e. modify
several parameters concurrently, and possibly updates the list of directions. The whole
process is repeated until the change in the fit distance χ2 after a full round becomes too
small.

A. Prerequisites
The Plugin is run on a high contrast image of a pendent drop (Fig. 6-left). Pixel values
are expected to be close to zero within the drop, and close to saturation (i.e. 255 for
8-bit images) outside. This is typically obtained by taking the picture of the drop in
front of a light background far away from the drop (Fig. 1). Bright spots well within the
drop are not a problem, but contrast should be good in the vicinity of the contour. Note
however that saturation should be avoided at all cost, both because of blooming effects
in the light sensitive image recording device and because it tends to bias the interface
detection towards the inside of the drop. See also section 2.

B. Pendent_Drop ImageJ Plugin Usage
By default, the Pendent_Drop Plugin appears in the Plugins menu of ImageJ, in a
folder termed Drop Analysis. The menu item About Pendent Drop will show a bit of
information on the Plugin, including usage, the update site and an example image on
which you can test the Plugin. The menu item Pendent Drop launches the Plugin itself.
Draw a rectangular Region Of Interest (ROI) around the pendent drop before calling

the Plugin (Fig. 6-middle). The ROI should not include the inlet tube, but only the free
surface of the drop. A few ten or so pixels margin around the drop is sufficient for the
interface detection to perform correctly.
Fill in any parameter values you know, and check the plausibility of the initial guess

for the others. If the image was calibrated for spatial scale, the corresponding scale is
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Figure 6: Plugin usage. (left) starting image, contrasted just short of saturating black
and white levels. (middle) image with rectangular ROI selection and initial guess next
to Plugin dialog. (right) The profile after automatic optimisation of the parameters.

proposed by the Plugin and all length scales are expressed in calibrated units. If the
image is not calibrated all lengths are given in pixels, including the resulting capillary
length. The angle specifies the tilt of the symmetry axis away from the vertical, in
degrees.
Two overlays are shown on the image: a blue line indicating the drop border as

detected by the Plugin, and a red line representing the profile described by the current
parameter values.
a) modify the parameters so as to improve the visual accordance of theoretical profile

and image. In version 2.0.0 of the Plugin a measure of the distance between profile and
border is logged to the console, it should be made as small as possible.
b) check those parameters that the Plugin may adjust and click on the button for

automatic minimisation. Only the previously checked parameters are varied when trying
to find an optimal shape. The overlay is updated accordingly. Note that the minimisation
algorithm can get trapped in a local minimum, so try starting from different initial values
and compare the results. Also check whether the resulting profile looks satisfactory.
Clicking the OK button will cause the Plugin to fit each slice of the active stack by a

drop profile. The dialog parameters serve as starting point for the fit of the first slice,
while subsequent slices are adjusted starting from the result of the previous slice. The
resulting drop shape descriptors, surface tension and drop properties (volume, surface)
for each slice are summarised in a result table.

How to get the surface tension If the image was scale-calibrated, and a sensible
value was entered for the ‘density contrast times g’ parameter (the difference of
the densities in/outside the drop multiplied by your planet’s gravitational acceleration,
(ρin−ρout)g = ∆ρ g), then the surface tension is indicated in physical units. For example
if the pixel size is in millimetres per pixel, and the density contrast times g is in
grams per square second and square millimetre (e.g. around 9.8 g mm−2 s−2 for water in
air on earth), then the indicated surface tension is in g s−2 or milli-Newton per metre.
Otherwise the unit conversion has to be performed by hand. Recall that surface tension
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γ is calculated from the capillary length using the formula γ = ∆ρg`2c .

C. Installing the Pendent_Drop Plugin for ImageJ
via the update site The preferred method is to use Fiji’s [2, 3] update mechanism. De-

tailed step-by-step instructions with illustrations can be found at http://fiji.
sc/How_to_follow_a_3rd_party_update_site. This software is hosted at http:
//fiji.sc/List_of_update_sites.
In the Help menu, select Update Fiji to start the updater. Choose the Advanced
mode, click on Manage update sites and add a site with the following URL:

http://sites.imagej.net/Daerr/

(The name has no particular importance, choose something meaningful to you)
Enable this site (check the box next to it) and close the window to get back to the
main updater window. In the list of Plugins, locate plugins:pendent_drop-2.0.0.jar
(to find it more easily you can restrict the list to items from the new site using the
menu above the list), select it and mark it for installation. Apply changes, restart
Fiji: a new folder Drop Analysis should appear in the Plugins menu.

by downloading the jar file For a manual installation, and as usual with ImageJ Plug-
ins, just put the jar into ImageJ’s plugins folder or a subfolder thereof. Restart
ImageJ to see the Plugin.

by building from the source The source code of the Pendent_Drop Plugin is hosted on
gitlab at https://github.com/adaerr/pendent-drop. You will need tools such
as git and a java compiler and be familiar with their usage. If you are using maven,
then the command mvn package should produce a jar file for you in the target
directory. Check the git history to identify usable states that you can check out
and compile.

References
[1] W. S. Rasband, ImageJ, U. S. National Institutes of Health, Bethesda, Maryland,

USA, http://imagej.nih.gov/ij/, 1997-2010.

[2] Fiji web site: http://fiji.sc/

[3] J. Schindelin et al., Fiji: an open-source platform for biological-image analysis, Na-
ture Methods 9(7), pp.676–682 (2012)

[4] M. J. D. Powell, Computer Journal 7 (1965) 155

[5] S. Brandt, Datenanalyse, BI-Wiss.-Verlag (Mannheim, Leipzig, Wien, Zürich) 3rd
edition, ISBN 3-411-03200-6 (1992)

11

http://fiji.sc/
http://fiji.sc/How_to_follow_a_3rd_party_update_site
http://fiji.sc/How_to_follow_a_3rd_party_update_site
http://fiji.sc/List_of_update_sites
http://fiji.sc/List_of_update_sites
http://sites.imagej.net/Daerr/
https://github.com/adaerr/pendent-drop
http://imagej.nih.gov/ij/
http://fiji.sc/


[6] F. M. Ernsberger and H. W. Pitman, New absolute manometer for vapor pressures,
Rev. Sci. Instrum. 26(6): 584–589; 1955. M. L. Huber, A. Laesecke and D. G. Friend,
The vapor pressure of Mercury, NISTIR report 6643 (2006), URL: http://www.
boulder.nist.gov/div838/SelectedPubs/NISTIR.6643.pdf

[7] D’Ans and Lax, Taschenbuch für Chemiker und Physiker, Springer, 1967 (3rd edi-
tion), pp. 1-134f, 1-600ff, 1-607, 1-901

[8] S. S. Joshi, Thermodynamic Interactions in Mixtures of Bromoform with Hydrocar-
bons, J. Phys. Chem. 95 (1991) 5299–5308

[9] L. I. Rolo, A. I. Caço, A. J. Queimada, I. M. Marrucho, and J. A. P. Coutinho, Sur-
face tension of Heptane, Decane, Hexadecane, Eicosane and Some of Their Bianary
Mixtures J. Chem. Eng. Data 47 (2002), 1442–1445

12

http://www.boulder.nist.gov/div838/SelectedPubs/NISTIR.6643.pdf
http://www.boulder.nist.gov/div838/SelectedPubs/NISTIR.6643.pdf

	Introduction
	Measurement bench
	Validation measurements
	Example of slow surfactant dynamics

	Physics of the pendent drop
	What the Plugin does internally
	Prerequisites
	Pendent_Drop ImageJ Plugin Usage
	Installing the Pendent_Drop Plugin for ImageJ

